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Overview 

Javelin3 and Javelin3Pro PDF Readers are free MS Windows programs that provide facilities for viewing standard PDF files, and for viewing 
encrypted (secure) versions of PDF files in formats (.drmz, .drmx) created for use with the Drumlin Digital Rights Management (DRM) service. 
The main difference between Javelin3 and Javelin3Pro is that the Pro version includes an initial step of software registration, as described 
in the next section - users of the standard version of Javelin3 can skip the registration section. Javelin3 and Javelin3Pro require Microsoft’s 
.NET (.NET) framework 4.5 or greater and up-to-date library files to work correctly, so require Windows 7 or greater and if Windows 7 then 
.NET 4.5 or later is required. If it is not installed Javelin3 will not run - to check, go to Control panel, click on Uninstall a program under 
Programs, and look for Microsoft .NET Framework in the list of installed programs. If .NET Framework 4.5 or later is not installed, please 
install it from the Microsoft website and try again. Alternatively use our Javelin version 2 software. Standard Windows 8, 10, 11 and any later 
versions of the Windows operating system are fully supported. 

Javelin3 can handle PDF and secure PDF files with many 1000s of pages, with fast page display, a wide range of zooming and page layout 
options, and very fast text searching. Documents can be marked up and annotations added, and where permitted, secure PDFs can be printed. 
Read-aloud (text to speech) is also now supported, as an aid for visually impaired readers. Javelin3 and Javelin3Pro store details associated 
with these programs in the current user’s AppData/Roaming/DrumlinSecurity folder on their PC – this folder may be hidden so to view it 
must be made visible, and then items such as settings and document Annots files (locally stored markup/annotations) can be viewed in the 
folder: C:\Users\<username>\AppData\Roaming\DrumlinSecurity\JavelinNew 

Javelin3 can be installed on any modern Windows platform, including all modern 32- and 64-bit MS Windows versions with current .NET 
installation included, including those installed on top of macOS/OSX using virtualization facilities such as Parallels. Touchscreen gestures are 
supported for selected devices such as the Microsoft Surface Laptop. Files can be directly opened by inclusion of the target filename to the 
command line, for example: "C:\Program Files (x86)\Javelin3\Javelin3.exe" c:\testfonts.pdf 

Communications with our DRM server for document authorization and related functions is provided by secure https connections using standard 
ports. Proxy server support is provided but is not required in most cases. Javelin3 and Javelin3Pro provide special facilities that enable secure 
files to be viewed without requiring online authorization, so should be used in cases where the local network security framework prevents 
the use of online authorization. Access control to secured PDF files is provided using authorization codes or document-and-device-specific 
license files, managed via our DRM Server. Permission controls that can be specified using DrumlinPublisher include Copy/Paste protection, 
Save as protection, Date expiry, Number of views permitted, Number of printouts permitted (if any), On-screen and On-print intelligent 
watermarking and screen capture protection for Windows PCs. From Javelin3 v3.01.13 onward pre-authorized .drmz file access is also 
supported. 

This manual is in the form of screen shots of the main functions provided by Javelin3 and Javelin3Pro – each of which is largely self-
explanatory, with text provided for each of the main forms and fields. For Accessibility please see the relevant section. 
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Javelin3Pro registration (not required for Javelin3 standard edition – skip to next section) 

Javelin3Pro asks for you to register before you can view secured PDFs (.drmz and .drmx files). The registration form is shown below – fields 
in yellow are required, i.e. must be completed. Once these fields, as a minimum, have been completed press the Register button and 
assuming there are no Connection access problems you will be registered and the Client ID and Code fields will be automatically completed 
for you and the form will close. Unless instructed otherwise, please do not tick the Change CompanyID box – this is only used for Company 
specific implementations. The Help button gives assistance on automatic versus Offline registration (see further, below) 

 

If you cannot connect to the registration server automatically, tick the Offline registration option and press the Web Registration Request 
button. This will access a web page on our server and enable you to register via this web page. The guidance on completion of the registration 
process will be shown on the web page and an email with the details will be sent to your email address. Use the HELP button to access further 
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help on registration. This includes a link to a web-based help page. If this is also not possible, you can use the Email Registration Request 
and this will create a text file for you that can be sent by email to the email address specified in the text file. An example is shown below: 

Please send the following text to e-mail address: info@drumlinsecurity.com 
-------------------------------------------------- 
First name: demo 
Last name: user 
e-mail: info@drumlinsecurity.com 
CompanyID: 6 
...  
DeviceID: 00260-00405-10432-AA375 
Application: Javelin Reader Pro v3.0.1.68 
 
Our team will then register your software manually and send you back the Client ID and Code values for you to copy and paste into the 
remaining fields shown in yellow highlight on the registration form (select the Tools menu, Registration option if required).  
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About the Drumlin DRM Service and DrumlinPublisher Software 

Source PDF files can be converted using our free DrumlinPublisher software to our proprietary 256-bit encrypted formats, which have file 
extensions .drmz (for cross-platform usage) and .drmx for desktop/laptop usage only. Files created using DrumlinPublisher can only be opened 
using our free family of Javelin PDF readers which are available for Windows, macOS/OSX, iOS/iPadOS and Android operating systems.  

When using this facility the source PDFs remain on the publisher’s PC – there are never transmitted to our servers unless they ask us to 
convert and host files on their behalf.  

Web browser-based PDF secure distribution is also available - please see our website page:  

https://www.drumlinsecurity.com/online.php or contact us for more details. 

DrumlinPublisher can be downloaded and used without charge from the DrumlinPublisher downloads page:  

https://www.drumlinsecurity.com/publisherdownloads.php  

Video demos of how to use the software are available at: https://www.drumlinsecurity.com/demos-mp4.php  

DrumlinPublisher can be installed on any modern Windows platform, including all modern 32- and 64-bit MS Windows versions with current 
.NET 4.5 or later installation included, including those installed on top of macOS/OSX using virtualization facilities such as Parallels. It can 
also be installed on multiple PCs - in this way multiple people in an organization can act as Editor/Publishers and Administrators. 

 

https://www.drumlinsecurity.com/javelindownloads.html
https://www.drumlinsecurity.com/online.php
mailto:info@drumlinsecurity.com
https://www.drumlinsecurity.com/publisherdownloads.php
https://www.drumlinsecurity.com/demos-mp4.php
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Opening screen 

When the Javelin3 or Javelin3Pro PDF Reader is run the first screen displayed will look similar to that shown below. When Javelin3Pro is run 
for the first time it will ask you to register your copy of the software (see above). With both versions you can open standard PDF files with 
file extension .pdf and files with extension .drmx and .drmz, which are encrypted versions of standard PDF files. The File menu, Toolbar 
Open files icon and Local files… facilities all provide access to opening all these file types. Recently opened files are also listed and can be 
clicked to open these. In standard Javelin3 use the Catalog option to open built-in catalogs of documents that you can download automatically 
with a single click (see next section of this user guide). In Javelin3Pro third party catalogs are not included and any catalog provided by a 
publisher would be downloaded manually using the built-in downloader facility (blue download icon in the main toolbar). 
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Downloading files and using Catalogs 

There are three main ways of obtaining the PDFs and secured PDFs (.drmz or .drmx files) you wish to view if they are stored on an external 
web server: (i) the publisher provides you with a web link for the file, you click on the link and using the download facility of your web 
browser you SAVE the file, e.g. to your DOCUMENTS folder, and then open it with Javelin3 or Javelin3Pro; (ii) you select the download icon 
on the toolbar and type in the web address provided, and Javelin will download the file for you; or (iii) click on the Catalog option and simply 
select the file or publisher’s catalog you require. Then select the file you want and it will download automatically – an example Catalog with 
sub-catalogs is shown below. A single click will invoke a download or select the options provided.  
 

  

Refresh catalog 
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Catalog facilities 
The catalog illustrated above includes an icon for refreshing (re-downloading) the catalog, which will update the available entries, plus a 
mix of downloaded files (e.g., the Alice in Wonderland example), pure PDF files (like this Javelin3 user guide), and other Catalogs that are 
specific to individual publishers – for example, LaSota Racing, as shown above. When any of these sub-Catalogs is clicked it will download 
the entries for that publisher’s catalog, which may in turn include additional sub-Catalogs (e.g. Science books, Art books, Course1, Course2, 
etc.). The top section of the catalog provides icons for: Going back, Closing the catalog facility, Refreshing the current catalog and displaying 
the catalog as a List or Grid (toggle icon). 
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Right clicking on a catalog (see example above) includes options to refresh the catalog, open the folder (in the user’s AppData directory) 
where the Catalogs and downloaded files are stored, and optionally to view the catalog itself as a text file. Info and Delete options are also 
provided.  

Right-clicking on a downloaded and authorized file will provide a similar range of facilities, as shown below: Delete (deletes the downloaded 
file and clears the registry settings for it, but does not delete the catalog entry), Info (Information about the file), Remove authorization (as 
per the matching File menu option) and Refresh options (re-downloads the file, and refreshes its cover image/thumbnail if provided by the 
publisher). 
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Downloader facility 
Javelin3 includes a built-in downloader, accessed via the Download icon or File menu. This provides a convenient mechanism for downloading 
and saving secure files, e.g. ga5.drmz, without using a web browser. The web address (URL) of the file to be downloaded is typed into the 
Download URL field (or copied and paste-d into this field) and the download takes places automatically to a local file location you specify 
(e.g., your Documents folder). When completed Javelin3 automatically asks if you would like to open the downloaded file, and if it is a newly 
downloaded secure PDF (.drmz or .drmx file) it will ask for an authorization code. A selectable list of previously downloaded files is displayed, 
so a history of the downloaded information is retained. Catalog files (in xml or zip format) can also be downloaded via this facility. 

 

Toolbar and menu elements 

Main Toolbar 
The main (upper) toolbar for Javelin3 is shown below – the sections may be enabled/hidden using the View menu, Upper Toolbar option. 
Element visibility is stored in the settings.cfg file in the program’s AppData folder. Tooltips explain each function are provided when the 
cursor is placed over the icon.  
 

 
 

Main operational functions, including text search Quick Navigation Page size selectors Rotation  Special selectors and markup  

From left to right, the Toolbar functions are described below (each of these sections can be hidden if required via the VIEW menu). 
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Main Toolbar operational functions and navigation:  

• Open file - opens a PDF or secured PDF (.drmz or .drmx file) – a single document can be opened at any one time, not multiple 
documents. See Open file section for more details 

• Print – prints PDF files, and for secured PDF files allows printing to physical devices if printing is permitted by the publisher 

• Close current document and return to main screen 

• Save – saves changes to documents – either mark-up/annotation or for forms, form data. The saved information is stored in a separate 
local file because secured PDFs are encrypted and not editable 

• Information (i) – provides PDF and DRM information relating to the currently open document 

• Download – built-in file downloader – see Download section for more details 

• Search text facility – see below for more details 
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Text search functions:  

• See the screenshot below for an example text search. Searching is extremely fast and can be parts of words (substrings) or entire 
phrases. Use the text search facility by typing Ctrl+F or via the Tools menu, Text search function, or via the search icon on the upper 
toolbar. Type in the text to search for – you can choose from 3 different search options (substring match, case specific, complete 
match). When the option to start the search is made, a list of hits with their page numbering is shown. Double-click on an entry to 
jump to that hit. Hits are highlighted in red 

 



Javelin3/Javelin3Pro PDF Reader for Windows – User Guide 

Drumlin Security Ltd  10 November 2022 – updated for build v3.0.1.70 and later Page: 13 

Quick Navigation: back (History) – forward (History) – provides in-context navigation (similar to the facilities provided in web browsers) plus 
quick page up/page down selectors 

Page size selectors: 

• 4 separate page size quick selectors – actual size, fit page, fit width, fit height 

Zoom and rotation functions: 

• Zoom in and out selectors plus selectable percentage zoom selector. Marquee zoom (select and zoom region of page) is provided via 
the Special Selectors marquee icon. A slider zoom facility is also provided on the lower toolbar (see further, below) 

• Left and right page rotation functions 

SPECIAL SELECTORS 

Mode and markup/annotation selectors: 

• The Hand mode selector (Hand icon) switches selection to grab/drag mode. In this mode the content can be dragged but not selected 
or hyperlinks actioned – switch to … 

• Select mode (Arrow icon) to select text, make highlights or annotations, and action links. The yellow mark-up icon selects mark-up 
mode – switch back to other modes to exit this facility. The annotation icon enables annotations to be added 

Marquee zoom: 

• This option zooms to a selected rectangular region, defined by dragging across the page with the left mouse button held down 

Lower toolbar and Status bar 
The Secondary toolbar for Javelin3 is provided at the foot of the program window and is shown below. It includes additional zoom selection 
and page navigation buttons, plus a choice of 4 separate page display formats: Single page mode, Continuous page mode with vertical scrolling 
up/down, Continuous page mode with horizontal scrolling left/right, and multi-page display with scrolling. 
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Below this toolbar is a set of status information relating to the current user and document, including counter and expiry date details. Use 
the zoom selectors or page size selectors to provide the best zoom level for the document you are viewing. 

Menu bar 
Javelin3 and Javelin3Pro provide a range of functions via the menu bar. These include: 

• File 

o Open – opening PDF, .drmx and .drmz files 

o Close – close file and display “home” page 

o Save As… - available for files of type PDF; enables files to be saved with a different filename, in PDF or TEXT format 

o Create backup copy – allows a PDF or DRMZ file to be copied to a backup location 

o Print – printing facilities for PDF and secured PDF files. Use the Tools menu, settings option to amend resolution 

o Recent files – list of recently accessed files (also available via the home page list) 

o Backup and restore facilities – these will create a special backup copy of a secured file AND its annotation/markup elements, 
which can be restored if so requested 

o Properties – PDF file and DRM properties 

o View notes – display annotation and markup details, by page, with options to print and/or save to rtf format file 

o Web authorization – bypasses the automatic authorization process and uses a web page to enable authorization of files when 
proxy servers or firewalls block the automated process 

o Remove authorization – clears stored settings for currently open file (or for entered documentID if no file is open) and removes 
authorization. Does NOT reset code 

o Download document – built-in file downloader for .drmz and .drmx files 

o Proxy settings – enable local proxy server access if required by your network. Otherwise enable the Server URL shown on the 
About form 

o Open log file – detailed activity log – used for diagnostics in case of any unresolved technical problems 

• View 

o Layout settings: Single page, vertical mode, horizontal mode, tiles 
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o Fit settings: Fit page, Fit width, Fit height 

o Presentation mode – a simplified view mode with support for page forward/back via single left/right mouse clicks or via a 
remote digital projector controller 

o Displayed elements:  

 Upper toolbar, select all or individual sections of the toolbar to remain visible if enabled 

 Show/hide navigation panel – this can be hidden via the icon on the navigation pane 

• Tools menu 

o Settings – specify print resolution – lower resolutions use less memory when printing (300dpi default), scaling options, 
navigation tree font size and whether or not form fields/links are highlighted. In addition, users can specify whether they 
want automatic updates checked, the color of the arrow annotation graphic, visibility of the sidebar and the default voice 
used for Text-to-Speech: 

 

  
o Find text (search, Ctrl+F) - invokes text search facility 
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o Registration (Javelin3Pro only) – access to the Registration form 

 

• Help menu 

o About – details of the software version, server location, contact details and access to the log file (for technical support) 

o Check for updates – manual check to see if the version used is the latest (also checked automatically by the latest versions of 
Javelin3 for Windows 

Touchscreen support 

Javelin3 supports Windows 10 & 11 devices that provide touchscreen operations, such as scrolling and zooming using “gestures”. The support 
is optimized for use with standard Windows operation rather than tablet devices/modes. Example devices include the Microsoft Surface 
Laptop and Microsoft Surface Pro (in desktop/laptop mode). For advice on Windows settings (including recommended screen resolution) 
please contact us. 

Keyboard and mouse support 

Javelin3 supports a wide range of mouse operations for use when a document is open (scrolling, left and right mouse clicks, dragging for text 
selection etc.), together with a number of standard keyboard operations (shortcuts). The latter include: HOME (go to top of document); END 
(go to bottom of document); Ctrl+C (copy select text – standard PDF files only); Ctrl+F (text search – cursor is moved to the text search box); 
PgUp and PgDn (larger page movements with the exact details depending on the page mode selected and the zoom level chosen). 

Right-click on document pages 
Right-clicking on a page displays a pop-up menu. With the following options: 

• Copy (for standard PDF files only; not permitted for protected files) 

• Read Selected Text By… (start speaking, read-aloud, select voice from those available to system) – right click again to Stop Speaking 

• Read Selected Text (start speaking, read-aloud, use default voice) – right click again to Stop Speaking 

• Read Page (start speaking, read-aloud) – right click again to Stop Speaking 

• Highlight selected text (in red, green, yellow or blue) 

• Add Annotation (text annotation – add, edit and delete included) 
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• Add Bookmark (personalized bookmark entry appears in sidebar, alongside bookmarks included by the publisher) 

• Draw Arrows (enter Arrow-drawing mode to add pointers to items, e.g. images, on the page) 

• Delete Highlight 

• Delete Arrow 

 

The screenshot below illustrates the use of the arrow and text annotation facilities – see further, the Annotation section 
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Opening Files 

When a standard or a secured PDF file is opened Outlines (also known as Navigation trees) are shown if they are included in the file – these 
can be hidden/enabled if required via the View menu or hidden using the  icon. If a secured PDF is opened the Javelin3 software will first 
ask for an authorization code or require a locally stored License file for the document in question before it will open it. In the example shown 
below a secured PDF file called ga6.drmz has been authorized. The + and – symbols on the Outlines tab enable you to increase or decrease 
the font size of the outline/bookmarks text. See the Bookmarking section for personalized bookmarks. 
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Authorizing a secured drmz or drmx file using an authorization code 

If you are opening a secured PDF (with .drmz or .drmx file extension) the software will prompt you for an authorization code (unless you are 
using Javelin3Pro and have been provided with a license file for the document in question) – an example is shown below for a drmz file. The 
code provided by the publisher can be copied and then the Paste button can be used to enter the code. When OK is clicked the code is 
checked over the internet. If the code is correct and approved the file will be opened automatically, and in most cases Javelin3 will not be 
ask for the code again. For documents not opened via a Catalog (which saves them automatically) It is important to make sure the document 
you are opening is saved to the Documents folder (or similar permanent location) before you try and authorize the PC to view it – avoid trying 
to open a file via an internet link, email attachment or located in a temporary file location as that may not work next time! 

 

Web authorization of drmz files 

The automatic authorization process may fail for a number of reasons, including “Authorization code already used” and various cases where 
your local or national network blocked the process as part of its proxy server or firewall settings – this will result in an error message like 
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“Internet connection not available” or “Empty response received” in which case a different method of authorization should be used assuming 
that an internet connection is actually available. The simplest solution to the latter problem is to select the option for WEB AUTHORIZATION. 
This facility is available on the Authorize Document form and in the File menu, Web Authorization option. 

This takes you step-by-step through the process – the basic elements of which are summarized below. Web authorization is only available for 
DRMZ files not DRMX files (see also the sub-section on License files if necessary): 

Web authorization is provided for users where the standard automated authorization fails due to local network and security constraints. If 
authorization fails with "Authorization code already used" please contact the document publisher for a new code or reset of your existing 
code. Ensure you include your authorization code when making this request. 

Web authorization is completed in two steps: 

Press the "Step One" button and a pop-up form will be displayed: 

(a) Enter the authorization code you have been given and your email address 

(b) Click the "Load Document" button to locate the .drmz file to be authorized 

(c) Click the OK button - this will direct you to our web site, where a "JMC code" will be generated for you. 

(d) Copy this this code because it will be needed in the second step 

Press the "Step Two" button: 

(a) Paste the JMC code into the field when prompted 

(b) Press the OK button to complete the authorization process and view your document 

If you still have problems with authorization, please contact the document publisher or our support team for assistance 
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Display formats 

Books authorized as in the above example will open and display in one of a series of formats, depending on your choices made via the View 
menu or using the View icons at the foot of the page. One such layout option is horizontal scrolling, enabling multi-page viewing with smooth 
scrolling left and right. Similar vertical scrolling viewing is available, as is page-by-page mode viewing. Zooming functionality is also provided 
via the main toolbar (page layout selectors and zoom buttons, and the zoom slider at the foot of the page. 
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Authorizing a secured .drmz or .drmx file using a license file 

Registered Javelin3Pro users may be provided with a license file to authorize their secured PDF file instead of an authorization code. A 
license file contains encrypted data that identifies the user’s device and the document for which access is required. The owner of the secured 
document generates a license file for that user and document and sends it, with the secured PDF, to the end user. Both the secured PDF and 
the license file must be located in the same folder, and then when the user runs Javelin3Pro and opens the secured file, it will open 
immediately without requiring any online authorization or code. 

License files can only be generated by publishers who are enabled for this facility or by our support team. For publishers to generate such 
license files Javelin3Pro must be registered to that publisher – this is achieved by specifying the CompanyID based on the value that the 
publisher provides.  

Javelin3Pro users who have already registered can use the Tools menu, registration facility, and the Unregister button to change their 
registration details – it is strongly recommended that the same firstname, lastname and email address are used as in the original registration 
– this will ensure your Client ID will remain unchanged and existing authorized files will remain available. License files include valid start/end 
date details for the file in question – these take precedence over any prior settings in the secured PDF itself. 

Pre-authorized .drmz files 

In general, a .drmz file that requires authorization using a code or license file will not ask for the code again on that specific device. Some 
publishers may also issue .drmz files that are pre-authorized and will never prompt for an authorization code. 

  



Javelin3/Javelin3Pro PDF Reader for Windows – User Guide 

Drumlin Security Ltd  10 November 2022 – updated for build v3.0.1.70 and later Page: 23 

Highlighting 

Text in a document can be selected by dragging with the mouse across it, and then it can be copied (PDF files only) and/or a Highlight can 
be added and saved. To highlight or copy text, select the text as shown below and then right click with the mouse to perform these functions. 
The highlight colour can be select from a range of colours. Any region that has been highlighted can have the highlight removed (deleted) by 
clicking on the relevant area and right clicking to delete. Mark-up mode can also be enabled via the toolbar Highlighting icon. See also here. 
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Annotation 

PDF and secure PDF files can be augmented with annotations, in much the same way that highlighting is implemented, i.e., via a right 
mouse click and selection from the pop-up menu provided or via the toolbar icon. The annotation is placed at the current cursor position 
and after entering the text for the note the entry can be saved by clicking on the tick icon or discarded using the x icon. The Red delete 
icon will delete the current note (with a prompt to confirm) this operation. Empty annotations are also removed by default. See also here. 
 

 
Annotations may also be made using the arrow icon in the toolbar or via the Draw Arrows option when right-clicking. Notes and Form data 
can be viewed and optionally printed, copied and/or exported via the File menu, View notes and form data facility. 
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Bookmarking 

In a manner similar to creating annotations, right-clicking on a page now includes the option to personally bookmark the page, with a brief 
description of the bookmark. This bookmark information is added to an additional tab in the sidebar, labelled Bookmarks, as illustrated below 
and can be saved for future use in accessing specific pages: 
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Forms processing 

Javelin3 for Windows (from version 3.0.1.38 onwards) supports PDF form data handling. A range of field types are supported, including text 
boxes (single and multiple line text entry fields), option selector, tick boxes, date fields, multi-item selectors and drop-down selectors. Field 
validation and required/optional settings are not supported thus all fields are available for editing. Field names should be simple text names 
with no special characters or delimiters – for example, text23, text24 etc. are acceptable field names, but text23-1.1, text23-1.2 etc. are 
not. It is recommended that text box fields are clearly defined with a visible border. As with standard PDF form usage, the tab key operation 
will move from field-to-field in sequence. 

PDF and secured PDF (.drmz) files are handled in different ways. For standard PDF files the field data is saved to a new, separate PDF file 
each time the file is saved, with the field data stored within the structure of the PDF in question. For secured PDF files, the files are encrypted 
and cannot contain additional stored data, so the details are stored within the separate annotations file maintained by the software. This 
data is merged with the PDF text and is then displayed, can be edited as required, and where printing is permitted, the completed forms 
with data entered are printed. In addition, data entered can be viewed, copied and saved/exported via facilities provided on the File menu 
(View Notes and Forms Data option). Forms processing is not currently supported on other versions of Javelin (i.e. earlier versions of our 
Windows software or similar Javelin software on other platforms). On these platforms forms can only be augmented using annotations (e.g. 
notes). 
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Network access and Proxy Servers 

Javelin3 includes a File menu item - Proxy Settings, enabling sites that require access via a Proxy Server to obtain access to the Drumlin 
DRM web service. The form for entering proxy server details is shown below. In almost all cases use of this facility will not be required, and 
if access is blocked by a firewall or proxy server, this can be overcome by asking the IT network support team to enable access to the DRM 
server: https://www.drumlinsecurity.co.uk/Service.asmx - if access is still restricted use Javelin3Pro. 
 

 

https://www.drumlinsecurity.co.uk/Service.asmx
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Moving authorized files to another computer/following an operating system change 

Sometimes it is necessary to move a file that has been authorized to a new computer, or to re-enable a file on a specific device whose 
operating system has undergone replacement or a major upgrade. The notes below explain how to handle these situations: 
 

Re-installed operating system/major upgrade 
Typically, these changes result in the Windows “registry” being re-installed and data stored in the registry being lost. Because Javelin readers 
stored authorization and associated data in the registry, this information will be lost. The solution in this case is to re-authorize the document 
using the code provided, and if that code fails with “Already used” then ask the document publisher to reset the code for you or to issue you 
with a new code, so you can start again on the same PC as before 

Moving between computers/new computer 
Typically, this occurs when you wish to use another PC (e.g., in the office rather than at home) or acquire a new PC. In this case you simply 
copy the .drmz or .drmx file(s) from your original PC to the new PC, install Javelin3 or Javelin3Pro on the new machine, and open the files 
you have copied across. Because this is a different PC there will be no authorization entries in the registry for the document(s) transferred, 
so each one will need separately authorizing on that device (either using an authorization code provided to you by the publisher, or by having 
the code supplied to you reset if necessary).  

If the original files have had markup or annotations added to them, these details will not be transferred because they are not stored inside 
the encrypted document (that would not be possible because the files are encrypted). Instead, this information is stored separately, typically 
in Annots files (locally stored markup/annotations) that can be viewed in the folder: 

C:\Users\<username>\AppData\Roaming\DrumlinSecurity\JavelinNew 

e.g. ppt-sample.Annots 

To carry the notes and markup across to a new computer the Annots files need to be copied across and placed in the matching AppData 
folder on the target PC. The File menu, Backup/restore facilities may be used for this purpose, as the backups they include the secured file 
and its annotations and markups file. 

With Javelin3 when Catalogs are used the default location for all catalog files, downloaded document cover images, and downloaded drmz 
files, is also in the AppData folder area. Right clicking within a catalog in Javelin3 will provide the facility to go to the folder where the 
documents are stored. 
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Branding or White Labelling 

Facilities for branding the Javelin3 Windows readers include: 

1. javelin.inc - html editable file with placeholders for key variables – this is the initial screen displayed when Javelin3/Javelin3Pro starts up 

2. settings.cfg - text file containing key settings - e.g., windows-size, recent files, recent catalogs downloaded, colour of selected elements 
etc., display of upper toolbar elements 

3. brandingdll.dll and javelin.bin - specifically built branding file, defining internal details including: program icons used within the program, 
about form link, catalog (document) icons if no cover image provided, about form text and link 

4. program name and program icon - can be amended but may need re-signing  

5. catalog.xml included in kit 

6. new kit specific to branded application 

7. Pro edition companyID if required 

Accessibility 

Javelin3 versions 3.0.1.42 onward support read-aloud facilities, with start speaking and stop speaking enabled for both entire pages and for 
selected text areas. This facility is available on Windows 8, 10 & 11 and makes use of the built-in text-to-speech facilities on the versions of 
MS Windows. Settings for these are defined via the Narrator facility (voice used and speed of speech etc.). Similar facilities are provided in 
Javelin3 for MacOS. 

Javelin3 also includes several facilities for zooming the PDF pages, including a zoom slider at the foot of the page and page layout icons at 
the top of the page (e.g., set to full page width). It is recommended that these facilities are used rather than changing the underlying MS 
Windows font size or display zoom levels, as these can confuse the Javelin3 software – leaving the latter at 100% is strongly recommended. 
Setting the display resolution to the level best suited for the user should be fine, however. For many screens, using the facilities in MS 
Windows to improve the clarity of text display is also recommended. 
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